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SUMMARY

Aggrephagy is a major way to clear protein aggregates. Here, we describe a
pipeline of experiments to find autophagy receptors for aggrephagy. Steps
include an in vitro reconstitution to recapitulate autophagosome recognizing ag-
gregates and receptor identification steps based on flow cytometry and mass
spectrometry. We also describe functional validation steps based on immunoflu-
orescence and immunoblot. The protocol provides a practical way to identify
aggrephagy receptors.

For complete details on the use and execution of this protocol, please refer to Ma
et al. (2022).

BEFORE YOU BEGIN

Many misfolded proteins can form intracellular protein aggregates. Here, we use the polyQ-HTT ag-
gregates formed by the Huntingtin (HTT) exon1 protein containing expanded polyglutamine (polyQ)
track as an example for screening and identifying new aggrephagy receptors. Other aggregation-
prone proteins such as Tau P301L, SOD1 G93A, and FUS P525L were also used for functional vali-
dation (but not for screening) in our previous study (Ma et al., 2022). The protocol below describes
the specific steps for using U20S cells. However, we have also used this protocol in N2a cells. When
using other cells, you need to conduct a preliminary test to calculate the amounts of cells for
achieving 1 million inclusion bodies (IBs) in each group to reach sufficient mass spectrometry depth.

Culture cell line

U20S cell expressing tetracycline-inducible HTT-Q91-mCherry was a gift from Dr. Ron Kopito lab.
As instructed, the cell line was generated by co-transfecting pTRE-Tight (Takara Bio Inc.
Cat#631059) carrying HTT-Q91-mCherry and linear puromycin marker (Takara Bio Inc. Cat#
631626) in a 20:1 weight/weight ratio into U20S TET-ON (Takara Bio Inc.) cells. 72 h after transfec-
tion, cells were selected in media containing 1 pg/mL puromycin and cloned with limited diluted
method. The clonal line exhibiting the highest HTT-Q91-mCherry fluorescence in the presence of
dox was co-transfected with pTRE-Tight and pcDNA3.1/Hygro in a 20:1 weight/weight ratio for
72 h and selected in media containing 500 pg/mL hygromycin, and clonal lines exhibiting the highest
HTT-Q%1-mCherry fluorescence were isolated by limited dilution cloning (Bersuker et al., 2016). The
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cells were maintained in DMEM supplemented with 10% FBS, 200 ng/mL puromycin, and
100 pg /mL hygromycin at 37°C in 5% CO2. This protocol can also be applied after transient
transfection (see “problem 1").

Purification and fluorescence labeling of LC3 protein
O® Timing: 4-5 days

1. Express the LC3 protein in E.coli BL21.

a. Transfect the pET28a-Cys-LC3B plasmid into E.coli BL21 competent cells and spread onto a
kanamycin selection plate. Incubate at 37°C for 12 h.

b. Pick a single clone into 5 mL LB broth media containing 50 pg/mL kanamycin and culture it at
37°C, 220 rpm for 12 h.

c. Inoculate 500 pL bacteria suspension into 500 mL LB broth medium containing 50 ng/mL kana-
mycin and culture at 37°C, 220 rpm until the OD600 reach 0.6-0.7.

d. Add 100 uM IPTG to induce protein expression at 22°C, 160 rpm for 12 h.

e. Collect bacteria by centrifuging at 5,000 x g for 30 min at 4°C and discard the supernatant.

f. Resuspend the bacteria pellet with 30 mL ice-cold PBS and transfer to a 50 mL tube. Collect
bacteria by centrifuging at 5,000 x g for 15 min at 4°C and discard the supernatant. The bac-
teria pellet can be directly used for the following purification or can be frozen at —80°C if
desired.

2. Purify the LC3 protein using Nickel Sepharose.

a. Resuspend the bacteria pellet with 15 mL ice-cold lysis buffer (2xPBS, 10 mM imidazole,
0.3 mM DTT, 150 pL protease inhibitor cocktail). Add a final concentration of 0.5 mg/mL lyso-
zyme and incubate on ice for 30 min.

b. Add a final concentration of 0.5% Triton X-100 and ultrasonicate the bacteria for 15 s and in-

terval of 30 s, repeat 4-6 times.
. Centrifuge the bacterial lysate at 45,000 x g for 40 min at 4°C.
. Prepare column containing 0.5 mL Nickel Sepharose. Equilibrate column by adding 20 mL ice-

o 0

cold 2xPBS and allowing the contents to drain.
e. Add the supernatant after centrifugation into the column, place the caps on the column and
incubate for 2 h on a rotor at 4°C.

—+

Remove the caps and drain the contents of the column.
g. Wash Sepharose with 50 mL ice-cold wash buffer A (2xPBS, 25 mM imidazole, 0.1%
Tween-20), followed by 50 mL ice-cold wash buffer B (2xPBS, 25 mM imidazole).
h. Elute protein with 5 mL ice-cold elution buffer (2xPBS, 250 mM imidazole).
3. Concentrate the LC3 protein and remove the imidazole.
a. Add the protein eluent into an Amicon Ultra 10k Centrifugal Filter and centrifuge at 4,000 X g
for about 30 min at 4°C to concentrate the protein eluent to 0.5 mL.

b. Equilibrate the PD miniTrap G-25 column with 10 mL ice-cold PBS and discard the flow-

through by gravity.

c. Add the 0.5 mL concentrated protein to the column and allow the contents to drain.

d. Elute protein with 1 mL ice-cold PBS and collect the protein eluent.

4. Determine the concentration of the LC3 protein.

a. Prepare a range of 0.5-5 pg/ul BSA dissolved in PBS as standard proteins.

b. Dissolve 1 pL LC3 protein and standard proteins in 10 uL 1x SDS loading buffer respectively.

c. Load the 11 plL samples into 12.5% PAGE gel and conduct SDS-PAGE as conventional

methods (a constant voltage of 80 V for stacking gel and 120 V for separating gel).

d. Stain the gel with Simply Blue (Invitrogen) as the instruction manual (https://assets.fishersci.
com/TFS-Assets/LSG/manuals/simplyblue_man.pdf). Image the gel and measure the band in-
tensities. Make a standard curve based on the BSA band intensities and corresponding
loading amount and calculate the concentration of the LC3 protein. About 5 mg LC3 protein
can be purified from 500 mL bacterial culture medium.
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e. The LC3 protein can be directly used for following fluorescence labeling or split into 1.5 mL
tube (100 pL each tube) and flash freeze in liquid nitrogen. The proteins can be stored at
—80°C for up to 5 years.

Caution: Take safety precautions when working with liquid nitrogen.
Note: Save some unlabeled LC3 protein for the in vitro reconstitution experiment below.

5. Fluorescence labeling of LC3 protein.

a. Dilute the LC3 protein with PBS to 100 uM (500 pl total volume) and incubate with 1 mM DTT
for 10 min at 4°C to reduce the disulfide bonds of proteins.

b. Remove excessive DTT with a PD miniTrap G-25 column by following steps 3b-d. 1 mL LC3
protein with a concentration of about 50 uM will be obtained after this step.

c. Dissolve the whole tube of Alexa Fluor 488 C2 maleimide (Invitrogen, 1 mg/tube) in 138.8 pL
DMSO to a concentration of 10 mM immediately before use and protect from light.

d. Add 100 pL maleimide stock solution to the 1 mL LC3 protein solution dropwise while stirring.
The final concentration of maleimide is about 1 mM (20 times of the LC3 proteins). The reac-
tion is allowed to proceed for 12 h at 4°C protected from light.

e. Add 3 mM glutathione (3 times of maleimide) to consume any unreacted thiol reactive
reagent.

f. Concentrate the protein solution into 0.5 mL and remove the free Alexa Fluor dye with a PD

miniTrap G-25 column by following steps 3b-d.
. Determine the concentration of the labeled LC3 protein by following steps 4a—d.

> Q

. Split the protein into 1.5 mL tubes (50 plL each tube) and flash freeze in liquid nitrogen. The
proteins can be stored at —80°C to avoid light for up to 5 years.

Caution: Take safety precautions when working with liquid nitrogen.

KEY RESOURCES TABLE

REAGENT or RESOURCE SOURCE IDENTIFIER
Antibodies

Mouse monoclonal anti-LC3. CST Cat#t M152-3;
Working dilution: 1:500 for IF. RRID: AB_1279144
Rabbit monoclonal anti-HA. CST Cat# 3724;
Working dilution: 1:2000 for WB, 1:500 for IF. RRID: AB_1549585
Rabbit monoclonal anti-GFP. CST Cat# 2956;

Working dilution: 1:5000 for WB.

Rabbit polyclonal anti-Ribophorin1(RPN1).
Working dilution: 1:5000 for WB.

Dr. Randy Schekman

RRID: AB_1196615
(Schindler and Schekman, 2009)

Chemicals, peptides, and recombinant proteins

LB Broth Agar

Sangon Biotech

Cat# A507003-0250

LB Broth Sangon Biotech Cat# A507002-0250
Kanamycin Inalco Cat# 1758-9316
NaCl Merck Cat# 106404

KCI Merck Cat# 104936
Na2HPO4 Merck Cat# 106586
KH2PO4 Merck Cat# 119898
HEPES Merck Cat# 391338
Sorbitol Merck Cati# 56755
Potassium acetate VWR Cat# VWRC85507.290
Magnesium acetate VWR Cat# VWRCO0131
SDS Solarbio Cat# S8010

Urea AMRESCO Cat# 0378

(Continued on next page)
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REAGENT or RESOURCE SOURCE IDENTIFIER
Glycerol Macklin Cat# G810575
2-Mercaptoethanol GEN-VIEW Cat# GM195
Bromophenol blue Solarbio Cat# B8120
Nickel Sepharose GE Healthcare Cat# GE17531802
Amicon Ultra 10k Centrifugal Filters Millipore Cat# UFC8010
PD miniTrap G-25 column GE Healthcare Cat# GE28918007
Simply Blue Invitrogen Cat# LC6060
Alexa Fluor 488 C2 maleimide Invitrogen Cat# A10254
DMEM Gibco Cat# C11965500BT
FBS Sunrise Cat# SR100180.03
Doxycycline Selleck Cat# S8608
Protease inhibitors Cocktail Sigma Cati# P8340

DTT GEN-VIEW Cat# CD116
Imidazole Sangon Cat# A600277
Tween-20 Macklin Cat# T6335

Triton X-100 AMRESCO Cat# T0694

BSA VWR Cat# 97061-420
Glutathione VWR Cat# VWRC0399
DNase | Sigma Cat# DN25
RNase A Sigma Cat# R5125
Ammonium bicarbonate Sigma Cat# A6141
Acetonitrile Thermo Scientific Cat# 85188
lodoacetamide Sigma Cat# 11149
Formic acid Thermo Fisher Scientific ~ Cat# 85178
Trypsin Promega Cat# V5280
X-tremeGENE HP DNA Transfection Reagent Roche Cat# XTGHP-RO
ProLong Gold Antifade Mountant Invitrogen Cat# P36930
Cycloheximide CST Cat# 2112S
Bafilomycin A1 Selleck Cat# S1413
Experimental models: Cell lines

U20S Cells Dr. Randy Schekman N/A

U20S Q91-HTT-mCherry Cells

Dr. Kirill Bersuker
(Dr. Ron Kopito lab)

(Bersuker et al., 2016)

Recombinant DNA

pET28a-His-LC3B
PEGFPN1-Q103-HTT
pBFPN1-Q103-HTT
pFUGW-empty

pFUGW-HA- (candidate receptors)

Lab stock
Lab stock
Lab stock
Lab stock
Lab stock

N/A
N/A
N/A
N/A
N/A

Software and algorithms

Fiji (ImageJ)
Prism 8
Flowjo

Proteome Discoverer
Alternative: Maxquant (https://www.
maxquant.org/)

(Schneider et al., 2012)
GraphPad

FlowJo

Thermo Fisher Scientific

https://imagej.nih.gov/ij/
https://www.graphpad.com
https://www.flowjo.com

https://www.thermofisher.cn/order/
catalog/product/cn/zh/OPTON-30810

Other

BD LSRFortessa

BD FACSAria SORP

Vacuum centrifuge CV200

UltiMate 3000 RSLCnano System
Thermo Q Exactive mass spectrometer

Alternative: LTQ Orbitrap velos, Orbitrap Fusion
Tribrid, Orbitrap Fusion LUMOS, Synapt G2, etc

Olympus FV3000 confocal microscope

Alternative: Nikon A1, Leica LSM780, etc

BD Biosciences

BD Biosciences

Beijing JM Technology
Thermo Scientific
Thermo Scientific

Olympus

N/A
N/A
N/A
N/A
N/A

N/A
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MATERIALS AND EQUIPMENT

2xPBS (pH 7.4) (1xPBS is directly diluted the 2xPBS with ddH,0)

Reagent Final concentration Amount
NaCl 274 mM 169
KCI 5.4 mM 049
Na2HPO4 20 mM 2.88¢g
KH2PO4 3.6 mM 0.49g
ddH,O N/A N/A
Total N/A 1L

Store at 4°C for up to 1 year after filtration sterilization.

5 M imidazole: Weigh 17 g imidazole and dissolve in ddH2O to a final volume of 50 mL.
Store at 4°C and avoid light for up to 1 year.

1 M DTT: Weigh 154 mg DTT and dissolve in ddH20O to a final volume of 1 mL.

Store at —20°C for up to 1 year.

The lysis buffer/wash buffer A/wash buffer B/elution buffer for protein purification are prepared
before use based on the 2xPBS according to the recipes in the steps.

B88 buffer

Reagent Final concentration Amount
HEPES (pH 7.2) 20 mM 2.38¢g
Sorbitol 250 mM 2277 g
Potassium acetate 150 mM 7.369g
Magnesium acetate 5mM 0.54 g
ddH,O N/A N/A
Total N/A 500 mL

Store at 4°C for up to 1 year after filtration sterilization.

Solutions used in the mass spectrometry sample preparations:

Decolorizing buffer: 50 mM Ammonium bicarbonate, 50% Acetonitrile (ACN).
Reduction buffer: 25 mM Dithiothreitol, 50 mM Ammonium bicarbonate.
Alkylation buffer: 55 mM iodoacetamide, 50 MM Ammonium bicarbonate.
Digestion buffer: 10 ng/mL trypsin, 25 mM Ammonium bicarbonate.
Extraction buffer: 0.1% Formic acid, 50% ACN.

Note: Prepare these solutions before use. ACN is toxic to inhale and highly flammable, solu-
tions that contain ACN should be prepared and used in a fume hood.

Aggregates solubilization buffer

Reagent Final concentration Amount
Tris-HCI (pH 6.8) 62.5 mM 0.38¢g
SDS 15% 759
Urea 8 M 24 g

(Continued on next page)
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Reagent Final concentration Amount
Glycerol 10% 5mL
ddH,O N/A N/A
Total N/A 50 mL
Heat to 40°C to dissolve.

Store at —20°C for up to 1 year.

4 x Loading buffer

Reagent Final concentration Amount
Tris-HCl (pH 6.8) 150 mM 091g
SDS 12% 69
Glycerol 30% 15 mL
2-Mercaptoethanol 6% 3mL
Bromophenol blue 0.2% 0.1g
ddH,0O N/A N/A
Total N/A 50 mL
Store at —20°C for up to 1 year.

Aggregates loading buffer

Reagent Final concentration Amount
Aggregation solubilization buffer N/A 3mL
4x Loading buffer N/A 2mL
ddH,O N/A 3mL
Total N/A 8mL
Store at 25°C for up to 1 month.

Transfer buffer

Reagent Final concentration Amount
Tris 25mM 69
Glycine 200 mM 30g
Methanol 20% 400 mL
ddH,O N/A N/A
Total N/A 2L
Pre-cold at 4°C and can be re-used 3-4 times.

TBST

Reagent Final concentration Amount
Tris-HCI (pH 7.6) 20 mM 2429
NaCl 137 mM 8g
Tween-20 0.2% (V/V) 2mL
ddH,0O N/A N/A
Total N/A 1L

Store at 25°C and use within 1 week.

STEP-BY-STEP METHOD DETAILS

In vitro reconstitution system

O® Timing: 1 day

The in vitro reconstitution system is to recapitulate the recruitment of autophagosomes to protein

aggregates by adding a fluorescence-labeled LC3 protein to the IBs formed by polyQ-HTT.

6 STAR Protocols 3, 101662, September 16, 2022
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1. In vitro reconstitution.
a. Plate about 8 x 10> U20S HTT-Q91-mCherry cells in a 6-cm dish. Maintain the cells in DMEM
supplemented with 10% FBS, 200 ng/mL puromycin, and 100 pg /mL hygromycin at 37°C in
5% CO2 for 12 h to allow the cells to adherence.

Note: We recommend users plate another dish of cell without expression of HTT-Q91-
mCherry to prepare a control sample for the following FACS analysis. The control sample
is prepared together with experimental group as the following 1c—f.

b. Incubate the cells with 1 ng/mL doxycycline for 24 h to induce the expression of HTT-Q91-
mCherry and IBs formation.

c. Wash cells once with 5 mL PBS, scrape off cells with a cell scraper in 1 mL PBS, and transfer into
a 1.5 mL centrifuge tube. Centrifuge at 600 X g for 5 min at 25°C to collect cells.

d. Add 400 uL B88 buffer plus 1% Triton X-100, 4 uL cocktail protease inhibitors (Sigma, solution),
100 U/mL DNase, and 1 U/mL RNase to the cell pellet and homogenize by passing through a
22 G needle for 10 times. (U refers to Kunitz unit here and below.).

e. Centrifuge at 300 x g for 8 min at 25°C, and carefully remove the supernatant.

f. Wash the pellet containing IBs with 1 mL B88 buffer plus 0.5% Triton X-100 and centrifuge
again at 300 x g for 8 min at 25°C.

g. Resuspend the pellet in 400 uL B88 buffer plus 0.5% Triton X-100, 4 pL cocktail protease in-
hibitors, 50 U/mL DNase and divide into four equal samples (Figure 1):
i. No protein added.
ii. Add 5-10 pg/mL fluorescence-labeled LC3 protein.
iii. Add 5-10 pg/mL fluorescence-labeled LC3 protein and 2-5 times BSA.
iv. Add 5-10 pg/mL fluorescence-labeled LC3 protein and 2-5 times non-labeled LC3 pro-

tein.

Incubate the reactions for 1 h at 30°C and protect from light.

Note: We tried a series of the concentration of fluorescence-labeled LC3 (from 0.5 pg/mL to
10 ng/mL). The different concentration only caused a variable LC3 fluorescence intensity on
IBs but didn’t change the results (the fluorescent LC3 on IBs can be competed by non-fluo-
rescent LC3 but not BSA).

h. Centrifuge at 1,000 X g for 5 min, wash the pellet with 500 uL PBS plus 0.5% Triton X-100 and
centrifuge again.
i. Resuspend the pellet in 500 pL PBS for FACS analysis.
2. FACS analysis of LC3 specific association with IBs.
a. Use a pulse shape analysis (PulSA) based on flow cytometry strategy (Ramdzan et al., 2013) to
quantify the recruitment of LC3 to the IBs:
i. Create histograms of mCherry-A and 488-A. Use the control sample and sample ii in step
1g to dynamically modify the range by adjusting the voltage of the PMTs until the sample
signal spans the full detector range.

i: None i
NeY FACS T i
sleis ii: Fluo-LC3 o
NG analysis £ IBs
o~ = 8 LY " A
L] et
SRS iv
7* iv:Fluo-LC3+LC3 ‘

mCherry-W 488
Figure 1. A scheme of major steps for the in vitro constitution system

Cells expressing mHTT IBs are lysed and centrifuged to collect IBs. Incubate the IBs with indicated proteins. Use flow
cytometry to analysis IBs and quantify the LC3 (488) on IBs.
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ii. Create a dot plot of pulse heights versus pulse widths of the mCherry.

Note: If your flow cytometry cannot collect the pulse width and height of the fluorescence, you

can also use the mCherry versus FSC.

b.

iii. By comparing the control sample with the experimental sample, gate the unique popula-
tion characteristic of IBs (Figure 1).

iv. Collect data for at least 20,000 IBs.

v. Analyze the fluorescence of LC3 (488) on IBs.

Compare the LC3 fluorescence on IBs in four different groups from step 1g. A successful

in vitro reconstitution should show no LC3 fluorescence in 19 (i), higher LC3 fluorescence in

1g (i & iii), and lower LC3 fluorescence in 1g (iv) because of the competition by non-labeled

LC3 (Figure 1).

Screen for candidate aggrephagy receptors

O® Timing: 1 day for step 3; 2-3 days for step 4

After establishing an effective in vitro reconstitution system, we divide IBs into two groups according
to the LC3 fluorescence and conduct an unlabeled quantitative mass spectrometry to compare pro-
tein components enriched in two groups.

3. Sort IBs into two groups (Figure 2).

a.

Plate U20S HTT-Q91-mCherry cells at 2 x 10° cells / dish in four 10-cm dishes. After 12 h,
add 1 pg/mL doxycycline for 24 h to induce the expression of HTT-Q91-mCherry and IBs
formation.

Wash cells once with 5 mL PBS and scrape off cells with a cell scraper in 3 mL PBS for each dish.
Transfer cell suspension into a 15 mL centrifuge tube. Centrifuge at 600 x g for 5 min at 25°C
to collect cells.

Add 1.6 mL B88 buffer plus 1% Triton X-100, 16 pL cocktail protease inhibitors (Sigma, solu-
tion), 100 U/mL DNase, and 1 U/mL RNase to the cell pellet and homogenize by passing
through a 22 G needle for 10 times.

d. Centrifuge at 300 x g for 8 min at 25°C, and carefully remove the supernatant.

Wash the pellet containing IBs with 1 mL B88 buffer plus 0.5% Triton X-100 and centrifuge
again at 300 x g for 8 min at 25°C.

Fluo-LC3 — e 1B
uo: © o analysis & S oo
—_—> °°° —>g —>r e
o
| 0% E|
° 4
Low-LC3 IBs
mCherry-W mCherry
FACS
sorting
Candidate Proteins enrich in Proteomic
receptors < High-LC3 IB ¢ analysis ¢ 09 °o
) o
High-LC3 IB Low-LC3 IB

Figure 2. A scheme of major steps to sort IBs

Cells expressing mHTT IBs are lysed and centrifuged to collect IBs. Incubate the IBs with fluorescent LC3. Use flow
cytometry to analysis IBs and divide IBs into two groups according to the LC3 fluorescence. Conduct proteomic
analysis based on mass spectrometry to identify proteins enrich in High-LC3 IBs as candidate aggrephagy receptors.
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f.  Resuspend the pellets in 1.6 mL B88 buffer plus 0.5% Triton X-100, 16 uL cocktail protease
inhibitors, and 50 U/mL DNase.

g. Add 0.5-1 pg/mL fluorescence-labeled LC3 protein to solution and incubate for 1 h at 30°C
in dark.

Note: The sorting steps need a larger reaction system than FACS analysis in step 1. To
save protein, we used a lower concentration of fluorescence-labeled LC3 compared to step 1g.

h. Centrifuge at 1,000 X g for 8 min, wash the pellet with 500 pL PBS plus 1% Triton X-100 and
centrifuge again.
Resuspend the pellet in 2 mL PBS for sorting two groups of IBs with flow cytometry:
i. Gate the population of IBs.
ii. Divide the IBs into two groups according to the LC3 fluorescence on them: High- LC3 IBs
and Low-LC3 IBs.

Note: The "High” and “Low” are the relative fluorescent intensity of LC3 under a specific
fluorescent intensity of IBs. You can mark the medians of LC3 intensity (488) under several
IBs intensity (mCherry) and join these points into a line. Signals above this line are
High-LC3 IBs and vice versa. Gate farther away the line will get more variability but waste
more samples.

iii. Sort 1 million IB particles for each group.

j-  The IB solutions were centrifuged at 3,000 x g for 30 min.

k. Add 25 pL Aggregates Loading buffer to the IB pellets and boil at 100°C for 10 min.

I. Load all samples into 10% PAGE gel and conduct SDS-PAGE as conventional methods
(a constant voltage of 80 V for stacking gel and 120 V for separating gel).

Note: Leave one lane empty between the two samples and the SDS-PAGE can be finished
when the bromophenol blue enters 3-4 cm into the separating gel to ease the following
processing.

m. Stain the gel with Simply Blue (Invitrogen) as the instruction manual (https://assets.fishersci.
com/TFS-Assets/LSG/manuals/simplyblue_man.pdf).

Note: It is good for the flow sorter to be able to collect the pulse width and height of the
fluorescence (e.g., BD FACSAria SORP). Otherwise, a BD influx also works in a two-color
gate mode.

4. Mass-spectrometry-based label-free quantification.

Note: The reagents in this workflow should use mass spectrometry grade reagents.

a. Excise the whole lanes above the bromophenol blue from the gel, each lane was split into
three samples of equal length to increase the number of protein identifications, then cut
the gel into small pieces less than 1 cubic millimeter.

b. Incubate the gel particles with 1 mL decolorizing buffer for 1 h, then remove the supernatant

(Figure 3A). Repeat decolorizing step twice to fully remove the Simple Blue dye.the

ACaution: ACN is toxic to inhale and highly flammable, all operations in this step should be
done in a fume hood.

c. Add 1mL 100% ACN and incubate for 10 min to dry the gel particles, then remove the super-
natant (Figure 3B). Repeat the drying step twice.
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Decolorizing buffer R
>

————>» Remove supernatant

1 hour

ACN
——————» Remove supernatant

Y

10 min

Figure 3. Gel particles destaining and drying
(A) The destaining step to remove the Simple Blue dye in gel particles with destaining buffer.

(B) Drying step to dry the gel particles with ACN.

10

d.

Add reduction buffer to submerge the gel particles and incubated at 55°C for 30 min for
cysteine reduction, then remove the supernatant and dry the gel particles with 1 mL 100%
ACN (repeat drying step twice) as previously described in step 4c.

. Add alkylation buffer to submerge the gel particles and incubate in dark for 30 min for
cysteine alkylation. Then, remove the supernatant and dry the gel particles with 1 mL 100%
ACN (repeat drying step twice) as previously described in step 4c.

Add 100 pL digestion buffer to each sample and replenish 25 mM ammonium bicarbonate so-
lution to submerge the gel particles. Incubate at 37°C for 12 h. After incubation, transfer the
supernatant to a new EP tube.

Recover the digested peptides from the gel using 200 ulL extraction buffer nd incubate for 1 h
at37°C. Afterincubation, transfer the supernatant to merge with the supernatant from step 4f.
Repeat recovering step twice.

Evaporate the solvent of the recovered solution by vacuum centrifugation.

Reconstitute the recovered peptides in 25 uL 0.1% formic acid for LC/MS analysis.
Online-desalt and analyze the recovered peptides using an UltiMate 3000 RSLCnhano System
(Thermo Scientific, USA) which was directly interfaced with a Thermo Q Exactive mass spec-
trometer (Thermo Fisher Scientific, USA).

Note: Other Liquid Chromatograph Mass Spectrometers (e.g., LTQ Orbitrap velos, Orbitrap
Fusion Tribrid, Orbitrap Fusion LUMOS, Synapt G2, etc) can also be used.

i. Separate peptide with UltiMate 3000 RSLCnano System using a 120-min gradient with
0.30 pL/min flow rate.

Note: Mobile phase A is consisted of 5% acetonitrile, 95% water, and 0.1% formic acid. Mo-
bile phase B is consisted of 80% acetonitrile, 20% water, and 0.1% formic acid. The analytical
column is a home-made fused silica capillary column (75 um ID, 150 mm length; Upchurch)
packed with C18 resin (300 A5 um; Varian).

ii. Acquire the MS/MS spectra with the Thermo Q Exactive mass spectrometer operated in
the data-dependent acquisition mode using Xcalibur 2.8 software.

STAR Protocols 3, 101662, September 16, 2022
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Note: Use a single full-scan mass spectrum in the orbitrap (300-1,800 m/z, 70,000 resolution)
followed by 20 loop count cycle of data-dependent MS/MS scans at 27 % normalized collision
energy (HCD).

k. Search the MS/MS spectra from each LC-MS/MS run against the Human Proteome (Uniprot)
database using an in-house Proteome Discoverer 1.4 software (Thermo Fisher Scientific).

Note: Set the search criteria as follows: Enzyme: Trypsin (Specific), carbamidomethylation
(C): fixed modifications, the oxidation (M): variable modification, precursor ion mass toler-
ances: 20 ppm for all MS acquired in an orbitrap mass analyzer, fragment ion mass tolerance:
0.02 Da for all MS2 spectra acquired, false discovery rate (FDR) was calculated using perco-
lator and the cut-of was set as 1%.

| Perform Relative protein quantification with Proteome Discoverer software according to man-
ufacturer’s instructions on the reporter ion peak area per peptide (https://files.mtstatic.com/
site_13984/6869/0?Expires=1659082727&Signature=qF2MFsBJLzTj7dbHtSdvLowrRIjjUiLL
poRwsxil~7wDLwVIMePyhYfMiU4OPDowP4rHDNRB5AUacLiw7bPZnfqQré1Zti7j3v5PzT5Fsw
wDHTVOTEwmNbA72nyka5FOelaFqUozrf4AdHbNnGee-He~FdNawMgg88Sbc3VHPss8_&
Key-Pair-ld=APKAJ5Y6AVAGI7A555NA).

Note: Other software such as Maxquant can also be used.

m. Use the peak area for protein abundance comparison between the High-LC3 IBs and Low-LC3
IBs. We recommend to choose the proteins whose ratio in High-LC3 IBs/Low-LC3 IBs > 2 and
the p-value < 0.05 (two-tailed t test from three independent experiments) as candidate recep-
tors for further study.

Generate the candidate receptor plasmid library
O® Timing: 1-2 weeks

Once finding out new candidate receptors enriched in High-LC3 IBs, prepare plasmids expressing
these proteins for further study. The gene can be cloned from cDNA or directly purchased from
plasmid suppliers (e.g., Addgene and Sino Biological). We prefer to tag the candidate receptors
with HA and insert them into the FUGW backbone. Other tags and vectors can also be used. In
the following steps, we take the HA-tagged candidate receptors as examples.

Autophagosome recruitment assay
O® Timing: 3 days

5. Immunofluorescence assay.

a. Plate U20S cells on coverslips in 24-well plate and culture for 12 h to 60%-70% confluency.

b. Transfect cells with Q103-HTT-BFP together with an empty plasmid or plasmids expressing
candidate receptors.
i. Dilute 0.2 ng Q103-HTT-BFP and 0.3 ng empty / candidate receptors plasmids into 50 pL

DMEM and gently pipette up and down to mix.

ii. Add 1 uL X-tremeGENE DNA transfection reagent to the diluted DNA and gently mix.
iii. Incubate for 20 min at 25°C.
iv. Add transfection complex to the cells in a dropwise manner.

Note: Other transfection reagents such as Lipofectamine 2000 Reagent (Invitrogen), and
Neofect Transfectoion Reagent (GenePharma) can also be used.
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c. 24 h after transfection, treat cells with 0.5 ng/mL Bafilomycin A1 for 2 h to accumulate the
tophagosomes in cells.

d. Dissolve digitonin in ddH2O to prepare 50 mg/mL stock solution. The stock solution can
stored at —20°C for 1 month.

e. Wash the cells with PBS and permeabilize cells with 40 ng/mL digitonin diluted in PBS on
for 5 min.

Note: The purpose of permeabilizing cells before fixation is to remove soluble proteins for
clearer observation of IBs.

STAR Protocols
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be
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f.  Wash the cells with cold PBS and immediately incubated them with 4% PFA for 20 min

at 25°C.

Permeabilize the cells again with 50 pg/mL digitonin diluted in PBS at 25°C for 10 min.
Block the cells with 10% FBS diluted in PBS at 25°C for 1 h.

i. Incubate with primary antibodies diluted in 10% FBS at 25°C for 1 h.

> @

Note: Antibody dilution depends on the affinity of your antibody. In our experiment, dilution
for LC3 antibody is 1:500, and for HA antibody recognizing HA-tagged candidate receptors
is 1:500.

j-

k.

Wash the cells three times in PBS for 5 min each.
Incubate with secondary antibodies diluted in 10% FBS at 25°C for 1 h in dark.

Note: We used the Alexa Fluor 568 (1:500) for HA and Alexa Fluor 647 (1:500) for LC3. Other
fluorescent secondary antibodies can also be used.

Wash the cells three times in PBS for 5 min each in dark.

m. Mount samples with a drop of ProLong Gold Antifade Mountant and dry at 25°C for 6-12 h in

d.

dark.

. Confocal microscopy imaging.
a.

Place the sample on the platform of a confocal microscope with a 60X objective (40X ~100x
objectives are suitable). We used the Olympus FV3000 for imaging, other confocal micro-
scopes (Nikon A1, Leica LSM780, etc) can also be used.

Find the cells under the eyepiece and switch to imaging mode.

Choose suitable channels: Alexa Fluor 405 for Q103-HTT-BFP, Alexa Fluor 568 for candidate
receptors, and Alexa Fluor 647 for LC3.

Preview the image and adjust focal plane, laser intensity, HV (High Voltage), etc.

Note: The optimum layer for observing IBs may be different from cells. Try to find the focal

plane that displays the clearest IBs.

e.

a.

Acquire fluorescence images for more than 50 IB-containing cells in each group.

. Quantify the LC3 area around IBs following the steps in Figure 4.
. Determine potential receptors for further study.

After obtaining the LC3 area around IBs from at least 50 IBs in each group, enter the results
into GraphPad Prism.

. Use unpaired T-test to analyze the difference between candidate receptor and control group.

Choose the proteins which can associate with IBs (Figure 6) and recruit more LC3 around IBs
compared to the control group (p<0.05) as potential receptors for further study.

Protein aggregates degradation

12

O® Timing: 3 days

STAR Protocols 3, 101662, September 16, 2022



STAR Protocols ¢ CelPress

a. Open the picture in image J.

b. Choose the BFP channel and change the image to 8-bit. (Image -> Type -> 8-bit)

c. Choose the Wand Tool and click the IB to circle it.
Double click the Wand Tool to display setting interface and adjust the Tolerance for best selectoin of IB.
Enlarge the selection by 1 ym. (Edit -> Enlarge -> Enlarge by 1 microns)

File Edit Image Process Analyze Plugins Window Help
clolalo] |4 |=PRA| x| o)F] ofsfu o] s]6] |»

Angle tool 1) Click

3) Double click

1) Adjust
ITolerance' | i ﬂl 118 Enlarge by |1 microns, -
Mode m [~ Pixel units e

[~ Enable Thresholding
I~ Smooth ifthresholded

Thresholded objects are traced and "Tolerance" oK Cancel

is ignored when thresholding is enabled.

OK Cancel

Enter negative number to shrink

d. Choose the LC3 channel and change the image to 8-bit. (Image -> Type -> 8-bit)
Create a suitable threshold to cover all the LC3 puncta signal. (Image -> Adjust -> Threshold)

[
—) =T

[Defautt — ~] [Baw |

[V Dark background | Stack histogram
I~ Dontresetrange

M Apply | Reset ﬂl

e. Show the IB selection in the LC3 channel. (Edit -> Selection -> Restore selection)
Quantify the LC3 area inside the IB selection. (Analyze -> Analyze particles)

Size (micron®2): |0-Infinity File Edit Font
I~ Pixel units Slice Count |[Total Area |Average Size ]%Area JMean
Circularty: [0.00100 Example-LC3 56 4993 0.089 11.801 160.984

Show: |Nothing hd )

I Display results I” Exclude on edges
I” Clear results I™ Include holes
v Summarize I Record starts

[~ Addto Manager I In situ Show

OK Cancel | Help 154
»

Figure 4. Steps for quantifying LC3 area around IB with image J
Detailed steps to quantify LC3 area around IB with image J after obtaining images. Step-by-step instructions are listed in the figure.

After finding out potential receptors that associate with IBs and recruit more autophagosomes, we
use a chase assay to explore the potential receptors’ effects on Q103-HTT degradation with cyclo-
heximide (CHX) inhibition of protein synthesis. Caution that when co-expressing with other proteins,
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Figure 5. A scheme of CHX chase assay
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Transfect cells with Q103-HTT-GFP together with an empty plasmid or plasmids expressing candidate receptors. 24 h

after transfection, add CHX and collect cells at indicated time. Perform immunoblot to analyze the amount of Q103

and candidate receptors.

the expression level of Q103-HTT may change. In order to unambiguously compare the degradation
level, adjust the amounts of Q103-HTT plasmids when transfecting cells to achieve similar initial

expression level of Q103-HTT in each group.

9.

10.

CHX chase assay (Figure 5).

a. Equally plate U20S cells in 24-well plate at 10° cells / well. Each group needs four wells

b. Transfect cells with Q103-HTT-GFP together with an empty plasmid or plasmids express
potential receptors.

ing

c. 24 h after transfection, treat cells with 50 pg/mL CHX, with or without 0.5 png/mL Bafilomycin

A1 as indicated.

Collect cells at indicated time points, lyse in 200 puL Aggregates loading buffer and boi
100°C for 10 min.
Immunoblot and analyzing.

d.

| at

a. Load 10 pul/sample into 10% PAGE gel and conduct SDS-PAGE as conventional methods (a

constant voltage of 80 V for stacking gel and 120 V for separating gel).

. Transfer proteins to 0.45 pm PVDF membranes. We recommend wet transfer method with a

constant current of 300 mA for 90 min. The transfer buffer should be pre-cold at 4°C, and the

transfer tank should be placed in ice bath.
c. Block membrane with 5% non-fat milk in TBST for 30 min at 25°C.
d. Wash membranes three times with TBST.
Incubate with primary antibodies diluted in TBST at 4°C for 12 h.

Note: Antibody dilution depends on the affinity of your antibody. In our experiment, dilution
for GFP antibody recognizing Q103-HTT-GFP is 1:5,000, for HA antibody recognizing HA-
tagged candidate receptorsis 1:2,000, for RPN 1 antibody is 1:5,000. RPN1 is used as internal
control. Other controls such as B-actin and GAPDH can also be used.

Wash membranes three times with TBST for 5 min each.
. Incubate with secondary antibodies diluted in TBST for 1 h at 25°C.
Wash membranes three times with TBST for 5 min each.

@

i. Detect immunoreactivity with Western Blot ECL chemiluminescent substrates and capture

images by ChemiDoc imaging system (Bio-Rad).
j- Quantify each band under the same threshold in ImageJ.

k. Calculate the ratio of GFP over RPN1 for each sample and normalize to the initial
value (time point 0) within each group. The decreased values reflect the degradation of

Q103-HTT.

EXPECTED OUTCOMES

The label-free quantification will give the values of peak area for hundreds of proteins in each
group. After comparing the protein components in High-LC3 IBs and Low-LC3 IBs, the known

14
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Figure 6. An example image for the autophagosome recruitment assay
Immunofluorescence of U20S co-expressing Q103-HTT-BFP and HA-tagged candidate receptor with anti-HA and
LC3 antibodies.

aggrephagy receptors such as P62, NBR1, TAX1BP1, and CCT2 will enrich in the High-LC3 IBs group
(Kirkin etal., 2009; Ma et al., 2022; Pankiv et al., 2007; Sarraf et al., 2020). Other proteins enriched in
High-LC3 IBs can be chosen as candidates for new aggrephagy receptors.

The autophagosome recruitment assay will primarily assess the ability of candidate receptors to
recruit autophagosomes. In most cases, the Q103-HTT-BFP will assemble into a regular IB about
5 pm in diameter. The proteins on the surface of IB are accessible for antibodies so that
the candidate receptors should form a shield around IBs in the confocal image. The autophago-
somes staining with LC3 antibody are usually 0.5-1.5 um in diameter and distribute throughout
the cell (Figure 6). The potential receptors will recruit more autophagosomes to [Bs.

The CHX chase assay will provide direct evidence to judge the function of the potential receptors.
Determine the aggrephagy receptors for further study referring to the following criteria: 1) Accel-
erate the degradation of Q103-HTT. 2) The degradation can be blocked by Bafilomycin A1. 3)
The receptors themself are degraded which can be blocked by Bafilomycin A1 (Figure 7).

LIMITATIONS

The common methods to find new autophagy receptors were detecting proximity interactome
of LC3 or known receptors (Zellner et al., 2021). However, because the composition of protein
aggregates is complex, it's hard to distinguish potential receptors for aggrephagy from the
LC3-interactome. In order to solve this problem, we developed this method to bridge the
aggregates-interactome and LC3-interactome. In this protocol, we use a pulse shape analysis
based on flow cytometry to analyze the large IBs formed by polyQ-HTT. The approach is only
applicable for analyzing large aggregates instead of small oligomers due to the limit of conven-
tional flow cytometry. For BD FACS Aria SORP, the minimum resolution of particle size is 0.2 pm,
so, we will miss some proteins that act specifically on small oligomers that are less than 0.2 pm.

TROUBLESHOOTING
Problem 1
The U20S Q91-HTT-mCherry cell line is not available (step 1: In vitro reconstitution).

Potential solution

You can also transfect a plasmid expressing fluorescent polyQ-HTT into U20OS or other cells to form
IBs if the cell line is not available. Ensure you can get enough IBs (20,000 for analysis in steps 1 and 2
and 1 million for mass spectrometry in steps 3 and 4) for the follow-up experiment.

Problem 2
No unique population of IBs during FACS analysis (step 2: FACS analysis of LC3 specific association
with IBs).
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Figure 7. An example result for the CHX chase assay
The turnover of Q103-HTT in a CHX chase assay with or without receptor proteins expression in U20S.

Potential solution

Confirm the fluorescent polyQ-HTT proteins have formed IBs in cells using a fluorescence
microscope. Induce with a higher concentration of doxycycline or extend expression time
if the IBs are not formed. You can use control samples without IBs to identify the unique
population.

Problem 3
Only few proteins are identified after comparing the mass spectrometry results of High-LC3 IBs and
Low-LC3 IBs (step 4: Mass spectrometry-based label-free quantification).

Potential solution
You can try to split each lane into 12 samples of equal length. It will reduce the complexity of each
sample and may find more low abundance proteins.

Problem 4
The fluorescence signals are weak (step 5: Immunofluorescence assay).

Potential solution
Increase the concentration of primary antibodies or incubate at 4°C for 12 h in a humidity chamber.

Problem 5
The fluorescence signals of IBs are so strong that interfere with other channels (step 6: Confocal mi-
croscopy imaging).

Potential solution

We recommend BFP or mCherry-tagged polyQ-HTT for their less interference. If you use a GFP-
tagged polyQ-HTT, avoid bright light excitation before imaging and take images of other channels
first.

Problem 6
The protein doesn’t decrease during treatment with CHX (step 9: CHX chase assay).

Potential solution

The CHX concentration and treating time depend on your cell types and states, so you may need to
explore a suitable condition for your cells. To make sure the CHX works, you can detect the degra-
dation of P62(SQSTM1) which is a typical cargo for autophagy. If the P62 performs well, you can try to
increase the chase time in case the candidate proteins work later.
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RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-
filled by the lead contact, Liang Ge (liangge@mail.tsinghua.edu.cn).

Materials availability

Plasmids and cell lines generated in this study will be made available upon request. We may require
a payment and/or a completed Materials Transfer Agreement in case there is potential for commer-
cial application.

Data and code availability
Any additional information required to reanalyze the data reported in this paper is available from the
lead contact upon request. This paper does not report original code.
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